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Legal Notice 

Copyright © 2006 Nokia. All rights reserved. 

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form without the 
prior written permission of Nokia is prohibited. 
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and company names mentioned herein may be trademarks or tradenames of their respective owners. 

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and improvements 
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Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental, 
consequential or indirect damages howsoever caused. 

The contents of this document are provided "as is". Except as required by applicable law, no warranties of any 
kind, either express or implied, including, but not limited to, the implied warranties of merchantability and fitness 
for a particular purpose, are made in relation to the accuracy, reliability or contents of this document. Nokia 
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1. ABOUT THIS DOCUMENT 

The purpose of this document is to describe the functionality of the Nokia Configuration Tool application. In 
addition, the document gives instructions for installing the application. Apart from the installation instructions, this 
document does not include any detailed step by step instructions. For step by step instructions and more detailed 
information, refer to the Nokia Configuration Tool help. 

1.1 TARGET AUDIENCE 
This document is meant for people who are responsible for maintaining settings information for Nokia devices and 
transferring updated settings to the Nokia devices. 

1.2 SCOPE 
This document introduces the Nokia Configuration Tool. 

• Chapter 1, About this document 
Provides the general information about the document. 

• Chapter 2, Introduction to the Nokia Configuration Tool 
Provides an introduction to the Nokia Configuration Tool as well as information about new features in this 
release. 

• Chapter 3, Installation 
Provides safety notes, system and security requirements, and instructions on how to install the Nokia 
Configuration Tool. 

• Chapter 4, Startup and shutdown of the Nokia Configuration Tool 
Provides information on how to start up the Nokia Configuration Tool and how to shut it down. 

• Chapter 5, Working with the Nokia Configuration Tool 
Provides information on how to work with the Nokia Configuration Tool. 

• Chapter 6, Profile settings 
Provides information on the profile settings available in different device types. 

• Chapter 7, Troubleshooting 
Provides troubleshooting instructions for problem situations. 

Having read this document, the reader will be familiar with the basic functions and possibilities of the Nokia 
Configuration Tool. 

1.3 RELATED DOCUMENTS 
For step by step instructions and more detailed information, refer to the Nokia Configuration Tool help. 

For other related information, refer to the following documents: 

• Nokia PC Suite user guide 

• The Nokia device user guide 

• The personal computer (PC) user guide 
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2. INTRODUCTION TO THE NOKIA CONFIGURATION TOOL 

The Nokia Configuration Tool is a PC application that enables you to manage the settings of selected Nokia 
devices. Your PC and the devices must be connected through Nokia PC Suite and a Universal Serial Bus (USB) 
cable. The Nokia Configuration Tool uses SyncML Data Synchronization (DS) and Device Management (DM) 
protocols, which are defined by Open Mobile Alliance (OMA). 

With the Nokia Configuration Tool, you can configure various settings, such as wireless LAN (if available), e-mail, 
and Internet access points (IAP), on several devices at a time. You can also transfer files, contact cards, and 
applications, if available. 

The configuration is done by sending a configuration profile to a phone. The configuration profile is a group of 
settings, and you can create several different profiles for different purposes and different types of devices. The 
settings that are defined in a profile are configured to a device when you transfer the profile to it. 

You can use a compatible connection cable (USB) to transfer configuration profiles to devices. For connectivity 
and system information, refer to Section 3.2, System requirements. 

To view the version, copyright date, and other important legal information about the Nokia Configuration Tool, 
select Help > About the Nokia Configuration Tool from the main menu. 

2.1 NEW FEATURES IN THIS RELEASE 
This release of the Nokia Configuration Tool has a search function that you can use to search for all items that 
contain a certain word. The search covers the contents of both the Devices tab and the Profiles tab, and the 
filenames of the profiles and contacts.  

This release also allows you to create new contacts in the Nokia Configuration Tool. In the previous releases, you 
could only import contacts. 
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3. INSTALLATION 

This chapter describes the system requirements, installation process and some safety and security issues. 

3.1 IMPORTANT SAFETY NOTES 
The safety instructions in the user guides of your device and PC apply when using the Nokia Configuration Tool. 

3.2 SYSTEM REQUIREMENTS 
To install and use the Nokia Configuration Tool, you need the following: 

• A compatible Nokia device 

• A PC with Windows XP™ or Windows 2000™ operating system (SP2 or newer) 

• Minimum display resolution of 1024 x 768 pixels 

• At least 250 MB of free disk space 

• Nokia PC Suite 6.7 or a later version 

• Internet Explorer 5.0 or later (for Nokia Configuration Tool help) 

• For connectivity, a USB connection port on your PC and a Nokia DKU-2 Connectivity Cable 

For information on connecting the device to your PC, refer to the Nokia PC Suite user guide, the Nokia device 
user guide, or the PC user guide. 

3.3 SECURITY REQUIREMENTS 
The Nokia Configuration Tool does not encrypt any information or settings that are saved and stored to your PC. 
For example, if you create a profile that contains passwords and user names, this information is not encrypted 
when you save the profile to your PC.  

If you want to encrypt the information and settings that are saved and stored to your PC, you must use a standard 
encryption program in your PC. For more information about encryption, refer to the PC user guide. 

3.4 INSTALLING 

 
Note: You must have the Nokia PC Suite installed on your PC before you can install the Nokia 
Configuration Tool. 

To install the Nokia Configuration Tool: 

1. Double-click on the Nokia Configuration Tool icon. The InstallShield Wizard opens. 

2. In the InstallShield Wizard window, click Next. 

3. If you accept the terms of the license agreement, check the appropriate box and click Next. 
You cannot install the Nokia Configuration Tool without accepting the terms. 

4. In the Choose Destination Location window, click OK or, if necessary, specify the location where you 
want to install the software, and click OK. 

5. Click Install. 

6. In the InstallShield Wizard Complete window, exit the wizard by clicking Finish. 
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4. STARTUP AND SHUTDOWN OF THE NOKIA CONFIGURATION 
TOOL 

Start the Nokia Configuration Tool from the Start menu or the Desktop of the PC by clicking the Nokia 
Configuration Tool icon. 

When you start the Nokia Configuration Tool for the first time, the tool prompts you to either select an existing 
workspace or create a new one. A workspace contains the device data files and configuration profiles for the 
devices. You can, for example, create different workspaces for different sets of devices. 

After you have selected whether to open an existing workspace or to create a new one, the workspace view is 
displayed. 

To exit the application, select File > Exit. 
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5. WORKING WITH THE NOKIA CONFIGURATION TOOL 

This chapter describes the navigation rules, workspaces, devices, profiles and search tools in the Nokia 
Configuration Tool. 

5.1 NAVIGATION RULES 
You can use keyboard shortcuts to quickly open menus in the workspace. Shortcuts allow you to open windows in 
the application using only the keyboard. Any menu or button that contains an underlined letter (for example, 
New...) can be quickly accessed by pressing the Alt key + the underlined letter (for example, Alt+N). 

5.2 WORKSPACES 
A workspace is a directory that contains device data files (the Devices tab) and configuration profiles (the 
Profiles tab). 

The underlined text at the top of the workspace window shows the title of the current workspace. 

By using the File menu, you can: 

• Open existing workspaces. 

• Create new workspaces. 
You can have multiple workspaces for different sets of devices and profiles. 

• Create a duplicate of the currently open workspace and all of its contents. 

• Delete an existing workspace. 

5.3 MANAGING DEVICES 
The Devices tab displays a list of all connected devices and all devices that have been modified. Use the 
Devices tab to view and manage all devices in the current workspace. 

In the Devices tab, you can: 

• Edit the settings of a single device online on your PC. You can access the same settings on the Profile tab 
too. For more information on the settings, refer to Chapter 6, Profile settings. 

• Send sets of edited settings and profiles to a device. 

• Edit device information. You can enter a name to identify a device, enter the personal ID of the user of the 
device, e-mail address and other info about the device. 

• Delete devices from the Nokia Configuration Tool. 
If you are connected to a device that you have removed from the list, the device is shown in the list of devices 
as a new device. 

 
Note: Before you can edit a device online or send settings (profiles) to a device, your PC and the 
device must first be connected using the Nokia PC Suite. 
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Note: When settings are imported from and sent to a device, a conversion is made between UTF-8 
(Unicode Transformation Format-8) and the operating system's default character map. You can 
send and import all characters which can be converted between UTF-8 and the operating system's 
default character map. 
Almost every language supports currency characters (such as, €, $ and £) and at least some 
mathematical operation characters. You can also send and import Scandinavian characters with the 
Nokia Configuration Tool, if the operating system's default character map supports Scandinavian 
characters. 

The devices list contains five columns: 

Column Description 

Device name Displays the name of the device. A new device displays the device IMEI code.  

Device type Displays the type of device. For example, Nokia 9300 (EA). 

Connection Displays an icon representing a connection between the PC and a device. A device 
that is shown but not connected displays None as the connection type. 

Last known profile Displays the name of the last known configuration profile in the device. A new 
device displays None as the last known profile. 

Sent Displays the date that the last known profile was sent to the device. A new device 
displays None as the date. 

To sort the list according to the contents of a column, click on the column heading. The arrow in the column 
heading indicates the sorting order. Click the column heading again to sort the list in the opposite order. 

5.4 PROFILES 
A profile is a group of settings, such as wireless LAN, e-mail, or Internet access point settings. Profiles are stored 
as an XML file in the workspace. You can create several different profiles for different purposes and for different 
devices. The settings that are defined in a profile are configured to a device when you send the profile to it. The 
available settings depend on the type of the device. 

Use the Profiles tab to view and manage all of the profiles in the current workspace. 

In the Profiles tab, you can: 

• Import profiles. 

• Create new profiles. 

• Edit and duplicate profiles. 

• Send profiles to devices. 

• Delete profiles. 

 
Note: Before you can send or import profiles and settings to a device, your PC and the device must 
first be connected using the Nokia PC Suite. 

 
Note: When profiles are imported from and sent to a device, a conversion is made between UTF-8 
(Unicode Transformation Format-8) and the operating system's default character map. You can 
send and import all characters which can be converted between UTF-8 and the operating system's 
default character map. 
Almost every language supports currency characters (such as, €, $ and £) and at least some 
mathematical operation characters. You can also send and import Scandinavian characters with the 
Nokia Configuration Tool, if the operating system's default character map supports Scandinavian 
characters. 

The profiles list contains three columns: 

Column Description 
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Profile name Displays the name assigned to the profile. 

Device type Displays the type of device. For example, Nokia 9300. 

Updated Displays the date the profile was last edited. 

To sort the list according to the contents of a column, click on the column heading. The arrow in the column 
heading indicates the sorting order. Click the column heading again to sort the list in the opposite order. 
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5.5 SEARCH TOOLS 
The Nokia Configuration Tool features three search functions. To find a specific device or profile in the list: 

• You can use the Advanced Search from the Tools menu to search for items in your devices and profiles.  In 
addition, the advanced search can be used to find profile and contact filenames. 

• In the Devices and Profiles tabs, you can use the Device type drop-down list to filter the devices and 
profiles according to the device type. 

• In the Devices and Profiles tabs, you can use the Show only items containing function filter the devices 
according to device attribute. 
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6. PROFILE SETTINGS 

The Nokia Configuration Tool allows you to create and edit settings, for example, for e-mail and Internet access 
points. You can store different sets of settings as profiles. For more detailed information of what settings are 
available for what devices, refer to the Nokia Configuration Tool help. 

 
Note: The available settings vary according to the type of device. 

 
Note: If you import the profile settings from the phone, edit the configuration profile in the Nokia 
Configuration Tool and then send the profile back to the phone, the profile settings are duplicated in 
the phone. Sending a profile to the phone never replaces the existing settings. 
If you want to edit settings that are already in the phone, you have to use the Nokia Configuration 
Tool’s Edit Online functionality. 

The following settings are available: 

• Internet access points: You can create new or duplicate, edit, or delete existing access point connections 
for the selected profile. GPRS / Packet data (proxies and IP configuration) and GSM / Data call (proxies, IP 
configuration and advanced) settings are available. IP Passthrough and WLAN (proxies, WEP keys, and IP 
configuration) settings are available for some devices. 

 
Note: WLAN and IP Passthrough settings are not available for all devices. 

• E-mail account settings: You can create new or duplicate, edit, or delete existing e-mail accounts for the 
selected profile. You can edit the name of the e-mail account, your name in the account, the e-mail address, 
the IAP and the SMTP server for the account. You can also define the IMAP4 or POP3 server as well as user 
names and passwords for them. Similarly, you can select whether to use SMTP authentication, and set the 
user names and passwords for it. 

 
Note: You must first create an IAP group before you can define the IAP in the e-mail account, SIP, 
IM server, and MMS settings. 
If the IAP you want is already defined in the phone and you do not want to modify the settings 
through the phone’s user interface, you can send the profile to the phone without the IAP setting, 
and then add the IAP to the needed IAP group while editing the profile online. 

• SIP settings: You can create, duplicate, edit and remove session initiation protocol (SIP) settings. You can 
edit the name of the profile, the service profile (IETF or Nokia 3GPP), access point, public user name, 
compression, registration, and security settings. You can also define the proxy and registrar server settings. 
Address, realm, user name, transport type (UDP or TCP) and port settings are available. You can also select 
whether to use loose routing with the proxy server. 

• IM server settings: You can create, duplicate, edit and remove IM server settings for the selected profile. 
You can edit the name of the IM server settings and also the access point, the web address, and your 
username and password to be used for the IM server. 

• Internet tel. settings: You can define which SIP settings profile you wish to use for Internet calls. 

 
Note: You must first create a SIP settings profile before you can define the SIP profile for Internet 
calls. 

• MMS settings: You can edit the multimedia message service (MMS) settings. You can select whether or not 
you want to send MMS settings, allow anonymous messages, receive advertisements, and allow report 
sending and receiving. Image size, MMS creation mode, access point, multimedia retrieval and message 
validity settings are also available. 

• SyncML (DS) / data synchronization settings: You can create new or duplicate, edit, or delete existing 
data synchronization (DS) profiles for the selected profile. You can define the profile name and the 
connection type (Bluetooth and data cable to synchronize with a PC; synchronizing with a server on the 
Internet is also possible). Note that some models do not support a data cable. You can edit the user ID and 
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the password for the synchronization server. If you select Internet as the connection type, you can define the 
access point and the port number of the synchronization server. 

• SyncML (DM) / device manager settings: You can create new or duplicate, edit, or delete existing device 
management profiles for the selected profile. You can select the connection type (Bluetooth and data cable to 
synchronize with a PC; synchronizing with a server on the Internet is also possible). Note that some models 
do not support a data cable. You can edit the name, ID and password for the synchronization server. Editing 
the host address is also possible. If you select Internet as the connection type, you can define the access 
point and the port number of the synchronization server. 

• Files: You can add files that you wish to transfer to a selected device. You can rearrange the files, specify a 
target folder for them and delete them. Note that this only edits the files and folder in the profile, not on the 
selected device. 

• Applications: You can add or delete applications, or change the installation order of the applications that you 
wish to transfer to a selected device. The added files must be compatible with the device to which you wish to 
send them. Software installation files must have the extension .jad, .jar, or .sis. Note that some models do not 
support this feature. 

• Contacts: You can import and delete contact cards and create contact cards to be transferred to a selected 
device. You can import a CSV file that contains contact information (You can export CSV files from Microsoft 
Outlook or other e-mail applications). The Contact dialog in the Nokia Configuration Tool accepts only VCF 
and CSV files. 



 

 

 

11/14  

7. TROUBLESHOOTING 

• Question: I connected my phone through Bluetooth and the Nokia Configuration Tool found it. Can I use 
a Bluetooth connection with the Nokia Configuration Tool? 
 
Answer: Even though the Nokia Configuration Tool found the phone, it does not officially support the 
Bluetooth connection type. You can use the Bluetooth connection only at your own risk. 

• Question: I connected my phone through Infrared and the Nokia Configuration Tool found it. Can I use an 
Infrared connection with the Nokia Configuration Tool? 
 
Answer: Even though the Nokia Configuration Tool found the phone, it does not officially support the 
Infrared connection type. You can use the Infrared connection only at your own risk. 

• Question: Nokia PC Suite does not detect my phone. What is the problem? 
 
Answer: Make sure that Nokia PC Suite supports your phone. If it does not, check if a newer Nokia PC 
Suite version is available on the web. If Nokia PC Suite does not detect your phone, you cannot use the 
Nokia Configuration Tool to configure your phone. 

• Question: Nokia PC Suite detects my phone but the Nokia Configuration Tool does not. What is the 
problem? 
 
Answer: Make sure that the Nokia Configuration Tool supports your phone. If it does not, you cannot 
configure your phone with the Nokia Configuration Tool. The supported phones are listed on the main 
page of the Nokia Configuration Tool. Check the contents of the Device type combobox. 
A connection problem between the phone and the PC may also cause the detection to fail. Reboot your 
computer, if possible, and restart the Nokia Configuration Tool. 

• Question: Neither Nokia PC Suite nor the Nokia Configuration Tool detects my phone. What is the 
problem? 
 
Answer: Make sure that Nokia PC Suite and the Nokia Configuration Tool support your phone. If they do, 
reboot your computer. 

• Question: I imported all the data from my phone to the Nokia Configuration Tool and then made some 
modifications. After that, I sent the profile back to my phone. Now I have duplicate settings on my phone. 
Why does my phone have duplicate settings, although I sent the original phone settings back to the 
phone? 
 
Answer: If you want to modify the settings that already exist on your phone, you have to use the "Edit 
Online" mode. If you import the settings and then send the same profile back to the phone, the existing 
settings are not replaced by the modified settings. Instead, duplicate settings are stored. 

• Question: The calendar and contact contents of a SyncML (DS) group are not transferred to my phone. 
What is the problem? 
 
Answer: When editing the profile settings online, avoid changing the settings of the default WLAN group, 
default SyncML (DS) group and default SyncML (DM) group. Changing these settings may cause 
problems. 

• Question: The WLAN WEP key ID, encryption and data values are not imported from my phone. What is 
the problem? 
 
Answer: For security reasons, those values are not imported from Nokia 9500 Communicator and Nokia 
9300i devices. 
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• Question: Why does the Contact transfer fail? 
 
Answer: If you transfer only one contact into a device and then deleting it from the device, the 
subsequent contact transfers fail. 

• Question: The GSM group settings with a high speed connection are not displayed in the Nokia 
Configuration Tool after importing. What is the problem? 
 
Answer: In some devices, if you have a GSM group with a high speed connection on the device, these 
settings cannot be displayed on the Nokia Configuration Tool after importing. 

• Question: Why does an import fail? 
 
Answer: With some computer configurations, importing may fail. In an error situation, restart the 
computer and the Nokia Configuration Tool. If that does not help, install the Nokia Configuration Tool on a 
different computer. 
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GLOSSARY 

ad hoc 

In the ad hoc mode, devices can send and receive data directly with each other and no wireless LAN access point 
is needed. 

CSV 

Comma Separated Value. File format which is used to exchange data between disparate applications. Each line 
is one entry or record and the fields in a record are separated by commas. 

DNS 

Domain Name Server. An Internet service that translates domain names such as www.nokia.com into IPv4 
addresses like 192.100.124.195. 

IAP 

Internet Access Point. An IAP is needed to connect to the Internet. 

IM 

Instant message. Enables you to create private chats with someone else. 

IMAP4 

IMAP4 is a version of Internet message access protocol, a standard protocol for accessing e-mail on your remote 
server. With IMAP4, you can search, create, delete, and manage messages and folders on the server. 

IMEI code 

International Mobile Equipment Identity. A number that uniquely identifies an individual mobile device. The IMEI 
usually appears on the label located in the battery compartment of the phone. 

infrastructure 

In the infrastructure mode, devices can communicate with each other and with wired LAN devices through a 
wireless LAN access point. 

GPRS 

General Packet Radio Service. GPRS is a technology that enables sending and receiving data over a mobile 
network. GPRS as such is a data bearer that enables wireless access to data networks like the Internet. The 
applications that use GPRS are, for example, Internet and e-mail. 

OMA 

Open Mobile Alliance 

PC 

Personal Computer 

POP3 

POP3 is a version of post office protocol, a standard protocol for receiving e-mail from your remote server. With 
POP3, you can check your remote mailbox and download your e-mail. 

SMTP 

Simple Mail Transfer Protocol. A protocol that is used to transfer e-mail messages. Usually SMTP is used only for 
sending. 
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SyncML 

Synchronization Markup Language. An open standard that enables synchronization of data between compatible 
devices, applications, and networks, which means that a consistent set of data is always available on any device 
or application. Sync ML is based on Extensible Markup language (XML). 

TCP 

Transmission Control Protocol. One of the protocols in the Internet protocol suite. The protocol guarantees 
reliable and in-order delivery of sender to receiver data. 

TLS 

Transport Layer Security. A protocol that guarantees privacy and data integrity between applications 
communicating over the Internet. 

UTF-8 

Unicode Transformation Format-8 

vCard 

Format of a contact card file which can be sent to other devices. vCard file has the file extension .vcf. 

WEP 

Wired Equivalent Privacy. A security feature using the RC4 algorithm that performs wireless data encryption. 
WEP keys consist of a secret key and a 24-bit initialization vector. For example, some manufacturers refer to a 
104-bit key as a 128-bit key (104+24). Both keys offer the same level of encryption and are therefore 
interoperable. 

WLAN 

Wireless Local Area Network. A local area network in which radio links are used to connect devices instead of 
physical cables. 

WPA 

Wi-Fi Protected Access. A security standard for wireless networks. 

802.1x 

A group of specifications for wireless LAN technology. 
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